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 � Note If you 
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support for assistance.
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Content link will appear 
under the product 
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Products tab.
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ANIMATING SYMBOLS 
WITH MOTION TWEENS

Lesson overview
In this lesson, you’ll learn how to do the following:

• Animate the position, scale, and rotation of objects using motion 
tweening.

• Adjust the pacing and timing of your animation.

• Animate transparency and filters.

• Change the path of an object’s motion.

• Create a nested animation.

• Split a motion tween.

• Change the easing of an object’s motion.

• Animate in 3D space.

This lesson will take about 2 hours to complete.

To get the lesson files used in this chapter, download them from the 
web page for this book at www.adobepress.com/AnimateCIB2022. For 
more information, see “Accessing the lesson files and Web Edition” in the 
Getting Started section at the beginning of this book.

3
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Use Adobe Animate to change almost any aspect 
of an object—position, color, transparency, size, 
rotation, and more—over time. Motion tweening is a 
basic technique for creating animation with symbol 
instances.
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Getting started
Start by viewing the finished movie file to see the animated title page that you’ll cre-
ate in this lesson.

1 Double-click the 03End.mp4 file in the Lesson03/03End folder to play the final 
animation, which was exported as a high-definition video file.

The project is an animated opener that would be placed on a website for an 
imaginary soon-to-be-released motion picture. In this lesson, you’ll use motion 
tweens to animate several components on the page: the cityscape, the main 
actors, several old-fashioned cars, and the main title.

2 Close the 03End.mp4 file.

3 Double-click the 03Start.fla file in the Lesson03/03Start folder to open the initial 
project file in Animate. This file is an ActionScript 3.0 document that is partially 
completed and already contains many of the graphic elements imported into the 
library for you to use. You’ll use all the animation functionality available in an 
ActionScript 3.0 document and then export an MP4 video file.

4 From the view options above the Stage, choose Fit In Window, or choose View 
> Magnification > Fit In Window, so that you can see the entire Stage on your 
computer screen.

5 Choose File > Save As. Name the file 03_workingcopy.fla, and save it in the 
03Start folder.

Saving a working copy ensures that the original start file will be available if you 
want to start over.

 � Note If you have not 
already downloaded 
the project files for 
this lesson to your 
computer from your 
Account page, make 
sure to do so now. See 
“Getting Started” at the 
beginning of the book.
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About animation
Animation is the change of an object’s appearance over time. Animation can be as sim-
ple as moving a ball across the Stage, which is a change in the object’s position. It can 
also be much more complex. As you’ll see in this lesson, you can animate many differ-
ent properties of an object. In addition to an object’s position, you can change its color 
or transparency, change its size or rotation, or even animate the filters that you saw in 
the previous lesson. You also have control over an object’s path of motion and even its 
easing, which is the way an object accelerates or decelerates its property changes.

In Animate, the basic workflow for animation goes like this: Select an object on the 
Stage and choose Create Motion Tween. Move the playhead to a different point in time 
and move the object to a new position or change one of its properties. Animate takes 
care of the rest by smoothly interpolating the changes between the two points in time.

Motion tweens create animation for changes in position on the Stage and for 
changes in size, color, or other attributes. Motion tweens require you to use a 
symbol instance. If the object you’ve selected is not a symbol instance, Animate will 
automatically ask to convert the selection to a symbol.

Animate also automatically separates motion tweens onto their own layers, which 
are called tween layers. There can be only one motion tween per layer, and there can 
be no other element on the layer. Tween layers allow you to change various attri-
butes of your instance at different key points over time. For example, a spaceship 
could be very small on the left side of the Stage at the beginning keyframe and much 
larger at the far-right side of the Stage at an ending keyframe, and the resulting 
tween would make the spaceship both fly across the Stage and slowly grow in size.

Understanding the project file
The 03Start.fla file contains a few of the animated elements already or partially 
completed. Each of the six layers—man, woman, Middle_car, Right_car, footer, and 
ground—contains an animation. The man and woman layers are in a folder called 
actors, and the Middle_car and Right_car layers are in a folder called cars.

 � Note The term 
“tween” comes from 
the world of classic 
animation. Senior 
animators would 
be responsible for 
drawing the beginning 
and ending poses 
for their characters. 
The beginning and 
ending poses were 
the keyframes of the 
animation. Junior 
animators would then 
come in and draw the 
“in-between” frames, or 
do the “in-betweening.” 
Hence, “tweening” 
refers to the smooth 
transitions between 
keyframes.
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You’ll be adding more layers to create an animated cityscape, refining the animation 
of one of the actors and adding a third car and a 3D title. All the necessary graphic 
elements have been imported into the library. The Stage is set at a standard HD size, 
1280 pixels by 720 pixels, and the Stage color is black. You might need to choose a 
different view option to see the entire Stage.

Animating position
You’ll start this project by animating the cityscape. It will begin slightly lower than 
the top edge of the Stage and then rise slowly until its top is aligned with the top of 
the Stage.

1 Lock all the existing layers so you don’t accidentally modify them. Create a new 
layer above the footer layer and rename it city.

2 Drag the bitmap image called cityBG.jpg from the bitmaps folder in the Library 
panel to the Stage in frame 1 of the city layer.
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3 In the Properties panel, set the value of X to 0 and the value of Y to 90.

This positions the cityscape image just slightly below the top edge of the Stage.

4 Select the cityscape image and choose Create Motion Tween above the timeline, 
or right-click and choose Create Motion Tween, or choose Insert > Create 
Motion Tween.

5 A dialog box appears warning you that your selected object is not a symbol. 
Motion tweens require symbols. Animate asks if you want to convert the 
selection to a symbol so that it can proceed with the motion tween. Click OK.

Animate automatically converts your selection to a symbol, with the default 
name Symbol 1, and stores it in your library. Animate also converts the current 
layer to a tween layer so that you can begin to animate the instance. Tween layers 
are distinguished by a special icon in front of the layer name, and the frames 
are tinted gold in the timeline. The range of frames covered by the tween is the 
tween span. The tween span is represented by all the colored frames from the 

 � Tip Although in this 
task you had Animate 
automatically convert 
your object into a 
symbol for tweening, 
it’s best practice to 
do it yourself before 
animating. That 
way, you control the 
naming and choice of 
the symbol yourself 
and have a better 
understanding of all 
your assets in your 
library.
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first keyframe to the last keyframe. Tween layers are reserved for motion tweens; 
hence, no drawing is allowed on a tween layer.

6 Move the blue playhead to the end of the tween span, at frame 191.

7 Select the instance of the cityscape on the Stage, and while holding down the 
Shift key, move the instance up the Stage.

Holding down the Shift key constrains the movement to the vertical or 
horizontal direction.

8 For more precision, set the value of Y to 0.0 in the Properties panel.

A small black diamond appears in frame 191 at the end of the tween span. This 
indicates a keyframe at the end of the tween.

Animate smoothly interpolates the change in position from frame 1 to frame 191 
and represents that motion with a motion path on the Stage.

 � Tip Temporarily hide 
all the other layers to 
isolate the cityscape 
and to better see the 
results of the motion 
tween.
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9 Drag the playhead back and forth at the top of the timeline to see the smooth 
motion. You can also choose Control > Play (or press Return/Enter) to make 
Animate play the animation.

Animating changes in position is simple because Animate automatically creates 
keyframes at the points where you move your instance to new positions. If you 
want to have an object move to many different points, simply move the playhead 
to the desired frame and then move the object to its new position. Animate takes 
care of the rest.

Previewing the animation
Integrated into the Timeline panel is a set of playback controls. These controls allow 
you to play, rewind, loop, or go step by step backward or forward through your 
timeline to review your animation in a controlled manner. You can also use the play-
back commands on the Control menu.

1 Click any of the playback buttons on the controller above the timeline to play, 
stop, or step forward or backward one frame. Hold the Step Forward or Step 
Backward button to move the playhead to the last or first frame.

2 Select the Loop button (to the left of the controller), and then click the Play 
button.

The playhead loops, allowing you to see the animation over and over for careful 
analysis.

3 Move the start or end markers in the timeline header to define the range of 
frames that you want to see looped.

The playhead loops within the marked frames. Click the Loop button again to 
turn it off.

Changing the pacing and timing
You can change the duration of the entire tween span or change the timing of the 
animation by dragging keyframes on the timeline.

 � Tip Remove a 
motion tween by 
selecting the tween and 
clicking Remove Tween 
in the Frame tab of the 
Properties panel. You 
can also right-click the 
motion tween on the 
timeline or the Stage 
and choose Remove 
Motion Tween.

 � Tip You can also 
use the Time Scrub tool 
(hidden under the Hand 
tool) to move back and 
forth on the timeline to 
preview your animation. 
Select the Time Scrub 
tool (or hold down 
Spacebar+T) and drag 
left and right on the 
Stage.
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Changing the animation duration
If you want the animation to proceed at a slower pace (and thus take up a much 
longer period of time), you need to lengthen the entire tween span between the 
beginning and end keyframes. If you want to shorten the animation, you need to 
decrease the tween span. Lengthen or shorten a motion tween by dragging its ends 
on the timeline.

1 Move your mouse pointer close to the end of the tween span in the city layer.

Your pointer changes to a double-headed arrow, indicating that you can lengthen 
or shorten the tween span.

2 Drag the end of the tween span back to frame 60.

Your motion tween shortens to 60 frames, reducing the time it takes the 
cityscape to move.
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3 Move your pointer close to the beginning of the tween span (at frame 1).

4 Drag the beginning of the tween span forward to frame 10.

Your motion tween begins at a later time, so it now plays only from frame 10 to 
frame 60.

Adding frames
You’ll want the last keyframe of your motion tween to hold for the remainder of the 
animation. Add frames by Shift-dragging the end of a tween span.

1 Move your pointer close to the end of the tween span.

 � Note If you have 
multiple keyframes in 
a tween, changing the 
length of the tween 
span by dragging 
one end or the other 
will distribute all your 
keyframes uniformly. 
The relative timing 
of events in your 
animation remains the 
same; only the length 
changes.
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2 Hold down the Shift key and drag the end of the tween span forward to frame 
191. Make sure that your tween span is not selected.

The last keyframe in the motion tween remains at frame 60, but Animate adds 
frames through frame 191.

Moving keyframes
If you want to change the pacing of an animation, you can select individual key-
frames and then drag them to new positions.

1 Click the keyframe at frame 60.

The keyframe at frame 60 is selected. Begin dragging the keyframe. A tiny box 
appears next to your mouse pointer, indicating that you can move the keyframe.

 � Tip You can also 
add individual frames 
by choosing Insert > 
Timeline > Frame (F5) 
or remove individual 
frames by choosing Edit 
> Timeline > Remove 
Frames (Shift+F5).
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2 Drag the keyframe to frame 40.

Now, because the last keyframe in the motion tween is reached earlier in the 
animation, the motion of the cityscape proceeds more quickly.

Span-based vs. frame-based  
selection
By default, Animate uses frame-based selection, which means you can select indi-
vidual frames within a motion tween. However, if you prefer to click a motion tween 
and have the entire span (the beginning and end keyframes and all the frames in 
between) be selected, you can enable Span Based Selection from the Frame View 
menu in the upper-right corner of the Timeline panel (or you can Shift-click to select 
the entire span).

With Span Based Selection enabled, you can click anywhere within the motion 
tween to select it, and move the whole animation backward or forward along the 
timeline as a single unit.

If you want to select individual keyframes while Span Based Selection is enabled, 
hold down Command/Ctrl and click a keyframe.
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Moving keyframes vs. changing 
time in tween spans
Managing the timing of your animation by moving keyframes and stretching or 
squashing tween spans can sometimes be frustrating because you will get different 
outcomes depending on what you’ve selected on the timeline and how you drag 
those selections.

If you want to simply move the location of a keyframe within a tween span, make 
sure that only a single keyframe is selected and that the tiny box appears next to 
your pointer as you begin dragging the keyframe to a new location.

If you want to select individual keyframes while Span Based Selection is enabled, 
hold down the Command/Ctrl key and click a keyframe.

Consider the following animation, where a ball moves from the left side of the Stage 
to the bottom edge and then to the right side, making a figure “V.” On the timeline, 
three keyframes mark the three positions of the ball.

Moving the middle keyframe changes the timing of when the ball hits the bottom 
of the Stage.

Keyframe moved
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When you select a span of frames within a tween, you can compress or expand its 
duration by dragging the selection when the double-headed arrow appears near 
the right edge of the selection. A black flag appears indicating when the amount of 
compression or expansion is a multiple of the original length (x0.5, x2, x4, etc.).

Frames compressed (half as much)  
    

Frames expanded (twice as much)

Understanding frame rate
The speed of your animation is tied to the frame rate of your document (shown in 
the Properties section of the Properties panel with the Document tab selected), but 
do not modify the frame rate to change the speed or duration of your animation.

The frame rate determines how many frames on the timeline make up 1 second of 
time. The default is either 30 or 24 frames per second (fps). The seconds are marked 
on the timeline. Frame rate is a measure of how smooth an animation appears—the 
higher the frame rate, the more frames there are to show the action. Animations 
at slower frame rates appear choppy because there are fewer frames to show the 
action. Slow-motion videography depends on very high frame rates to capture 
action that happens very quickly, such as a speeding bullet or a falling water 
droplet.

If you want to modify the overall duration or speed of your animation, don’t change 
the frame rate. Instead, add frames to, or delete frames from, your timeline.

If you want to change the frame rate but keep the overall duration constant, select 
the Scale Spans option in the Properties panel before you modify the frame rate.
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Animating transparency
In the previous lesson, you learned how to change the color effect of any symbol 
instance to change the transparency, tint, or brightness. You can change the color 
effect of an instance in one keyframe and change the value of the color effect in 
another keyframe, and Animate will automatically display a smooth change, just as 
it does with changes in position.

You’ll change the cityscape in the beginning keyframe to be totally transparent but 
keep the cityscape in the ending keyframe opaque. Animate will create a smooth 
fade-in effect.

1 Move the playhead to the first keyframe of the motion tween (frame 10).

2 Select the cityscape instance on the Stage.

3 In the Color Effects section of the Properties panel, choose Alpha from the Style 
menu.

4 Set the Alpha value to 0%.

The cityscape instance on the Stage becomes totally transparent, but you can still 
see the blue bounding box around it.
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5 Move the playhead to the last keyframe of the motion tween (frame 40).

6 Make sure that the cityscape instance on the Stage is still selected.

7 In the Properties panel, in the Color Effects section, set the Alpha value to 100%.

The cityscape instance on the Stage becomes totally opaque.

8 Preview the effect by choosing Control > Play (or pressing Return/Enter).

Animate interpolates the changes in both position and transparency between the 
two keyframes.

Animating filters
Filters, which give instances special effects such as blurs and drop shadows, can also 
be animated. You’ll next refine the motion tween of the actors by applying a blur 
filter to one of them to make it appear as if the camera changes focus. Animating 
filters is no different from animating changes in position or changes in color effect. 
You simply set the values for a filter at one keyframe and set different values for the 
filter at another keyframe, and Animate creates a smooth transition.

1 Make sure that the actors layer folder on the timeline is visible.

2 Unlock the woman layer.

 � Note Filters can 
be applied, but not 
animated, in an HTML5 
Canvas document.
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3 Move the playhead to the beginning keyframe of the motion tween in the woman 
layer, at frame 23.

4 Select the instance of the woman on the Stage. You won’t be able to see her 
because she has an alpha value of 0% (totally transparent). Click the upper-
right side of the Stage to select the transparent instance. Or click frame 23 in 
the woman layer in the timeline to highlight it, then click the Object tab in the 
Properties panel.

5 In the Properties panel, click the Add Filter (+) button in the Filters section, and 
choose Blur from the menu to add a blur to the instance.
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6 In the Filters section of the Properties panel, select the link icon to apply equal 
values to the x and y directions if it isn’t already selected. Set the Blur X value 
to 20 pixels.

The Blur Y value also changes to 20 pixels.

7 Move the playhead along the entire timeline to preview the animation.

The woman instance is blurred throughout the motion tween.

8 Select frame 140 in the woman layer and choose Insert Keyframe above the 
timeline.

Animate establishes a keyframe at frame 140.

9 Select frame 160 of the woman layer and choose Insert Keyframe above the 
timeline to add another keyframe.
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10 Select the Object tab of the Properties panel.

11 In the Properties panel, change the value of the Blur filter to X=0 and Y=0.

The Blur filter changes from the keyframe at frame 140 to the keyframe at 160. 
Animate creates a smooth transition from a blurry instance to an in-focus 
instance.

Understanding property keyframes
Changes in properties are independent of one another and do not need to be tied 
to the same keyframes. That is, you can have a keyframe for position, a different 
keyframe for the color effect, and yet another keyframe for a filter. Managing many 
different kinds of keyframes can become overwhelming, especially if you want dif-
ferent properties to change at different times during the motion tween. Fortunately, 
Animate provides a few helpful tools for keyframe management.

When viewing the tween span, you can choose to view the keyframes of only cer-
tain properties. For example, you can choose to view only the Position keyframes so 
that you can see when your object moves. Or you can choose to view only the Filter 
keyframes so that you can see when a filter changes. Right-click a motion tween in 
the timeline, choose View Keyframes, and then choose the desired property from 
the list. You can also choose All or None to see all the properties or none of the 
properties.

 � Tip Click the Enable 
or Disable Filter button 
in the Filters section of 
the Properties panel to 
toggle the visibility of 
the filter effect on your 
animation to make your 
work easier. The Enable 
or Disable Filter option 
doesn’t affect the final 
exported animation, 
however.

 � Tip You can add 
more than one filter 
to an animation. Drag 
the filters to rearrange 
the order in which they 
appear in the Properties 
panel, or collapse each 
filter to save space in 
the panel.
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When inserting a keyframe, you can also insert a keyframe specific to the property 
you want to change. Right-click a motion tween in the timeline, choose Insert 
Keyframe, and then select the desired property.

You can also view an advanced panel, called the Motion Editor, to see and edit how 
the different properties of your object change over the course of the motion tween. 
You’ll learn more about the Motion Editor in the next lesson.

Animating transformations
Now you’ll learn how to animate changes in scale or rotation. These kinds of 
changes are made with the Free Transform tool or with the Transform panel. You’ll 
add a third car to the project. The car will start small and then become larger as it 
appears to move forward toward the viewer.

1 Lock all the layers on the timeline.

2 Insert a new layer inside the cars folder, and rename it Left_car.
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3 Select frame 75 and insert a new keyframe (F6 or Insert Keyframe button).

4 Drag the movie clip symbol called carLeft from the Library panel to the Stage at 
frame 75.

5 Select the Free Transform tool.

The transformation handles appear around the instance on the Stage.

6 While holding down the Shift key, drag a corner handle inward to make the car 
smaller.

7 In the Properties panel, make sure that the width of the graphic is about 400 
pixels.

Alternatively, you can use the Transform panel (Window > Transform) and 
change the scale of the car to about 29.4%.
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8 Move the car to its starting position at about X=710 and Y=488.

9 In the Properties panel, in the Color Effects section, choose Alpha from the Style 
menu.

10 Set the Alpha value to 0%.

The car becomes totally transparent.

11 Choose Create Motion Tween from the button above the timeline.

The current layer becomes a tween layer.

12 Move the playhead to frame 100.

13 Make sure the transparent instance of the car on the Stage is selected, and in the 
Properties panel, change the Alpha value to 100%.

A new keyframe is automatically inserted at frame 100 to indicate the change in 
transparency.
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14 While holding down the Shift key, drag a corner handle outward to make the car 
larger. For more precision, use the Properties panel and set the dimensions of the 
car to width=1380 pixels and height=445.05 pixels.

15 Position the car at X=607 and Y=545.

You have used Animate to tween the change in position and the change in scale 
as well as the change in transparency from frame 75 to frame 100.

16 Move the Left_car layer in between the Middle_car and Right_car layers so that 
the car in the center overlaps the cars on the side.

Save your progress so far in this document, 03_workingcopy.fla.

Editing multiple frames
If you need to make the same change across multiple keyframes, you can use the 
Edit Multiple Frames option above the timeline. The option allows you to make edits 
that affect many keyframes in the same layer or even across many different layers.

For example, imagine that you liked the animation of the cars in this project, but 
you wanted to move the animation to a different location on the Stage. Instead of 
moving every instance at each keyframe of the animation, the Edit Multiple Frames 
option lets you do one move for all of them at once.

 � Tip Holding down 
the Option/Alt key 
while dragging one 
corner handle of the 
bounding box causes 
the box to resize 
relative to the opposite 
corner rather than 
relative to the object’s 
transformation point 
(usually the center).
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Moving the animation of the cars
You will move the animation of the cars so that they are centered on the Stage.

1 Lock all the layers except the layers in the cars folder.

2 Select and hold the Edit Multiple Frames option above the timeline and choose 
All Frames.

Brackets appear on the timeline indicating the span of frames that will be 
editable. The All Frames option automatically puts the brackets at the beginning 
and end to encompass all the frames of the timeline.

Choose Selected Range if you want to select only a span of frames. With the 
Selected Range option, you can move the beginning or end bracket.

3 Choose Edit > Select All (Command+A/Ctrl+A).

All the frames in the layers of the cars folder become selected.
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4 While holding down the Shift key, drag the selected group of cars to the left of 
the Stage. Move the group so that they are generally centered on the Stage.

You are actually moving multiple instances in multiple keyframes across all three 
layers at the same time.

5 Deselect Edit Multiple Frames.

6 Scrub the timeline from frames 70 to 191.

The three cars remain animated with changes in size, color effect, and position, 
but they have been moved to the center of the Stage.

Save your work. In the next section, you’ll work with a different file.

Changing the path of the motion
The motion tween of the left car that you animated shows a colored line with dots 
indicating the path of the motion. You can easily edit the path of the motion to make 
the car travel in a curve, or you can move, scale, or rotate the path just like any other 
object on the Stage.
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To better demonstrate how you can edit the path of the motion, open the sample 
file 03MotionPath.fla in the Lesson03/03Start folder. The file contains a single 
tween layer with a rocket ship moving from the top left of the Stage toward the 
bottom right.

Moving the path of the motion
You will move the path of the motion so that the relative movement of the rocket 
ship remains the same but its starting and ending positions change.

1 Select the Selection tool.

2 Click the path of the motion to select it.

The path of the motion becomes highlighted.

3 Drag the motion path to move it to a different place on the Stage.
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The relative motion and timing of the animation remain the same, but the 
starting and ending positions are relocated.

Changing the scale or rotation of the path
You can also manipulate the path of the object’s motion using the Free Transform 
tool.

1 Select the path of the motion.

2 Select the Free Transform tool.

Transformation handles appear around the path of the motion.

3 Scale or rotate the path of the motion as desired. You can make the path smaller 
or larger or rotate the path so that the rocket ship starts from the bottom left of 
the Stage and ends at the top right.
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Editing the path of the motion
Making your objects travel on a curved path is a simple matter. You can edit the 
path with Bezier precision using anchor point handles, or you can edit the path in a 
more intuitive manner with the Selection tool.

1 Select the Convert Anchor Point tool, which is hidden under the Pen tool.

2 Drag from the starting point and the ending point of the motion path on the 
Stage to pull control handles out from each anchor point.

The handles on the anchor points control the curvature of the path.

3 Select the Subselection tool.

4 Drag the handles at either end of the path to edit its curve. Make the rocket ship 
travel in a wide curve.

 � Tip You can also 
directly manipulate 
the path of the motion 
with the Selection tool. 
Select the Selection tool 
and make sure the path 
is deselected. Move 
your pointer close to 
the path of the motion. 
A curved icon appears 
next to your pointer, 
indicating that you can 
edit the path. Drag the 
path of the motion to 
change its curvature. 
Choose the spots where 
you drag carefully! Each 
drag breaks the path 
into smaller segments, 
making it harder to 
achieve a smooth curve. 
Mastery will come with 
practice.
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Orienting objects to the path
Sometimes the orientation of the object traveling along the path is important. In 
the motion picture promotional project, the orientation of the car is constant as it 
moves forward. However, in the rocket ship example, the rocket ship should follow 
the path with its nose pointed in the direction in which it is heading. Orient To Path 
in the Properties panel gives you this option.

1 Select the motion tween on the timeline (Shift-click to select the whole tween).

2 In the Properties panel, under the Tweening section, select the Orient To Path 
option.

Animate inserts keyframes for rotation along the motion tween to orient the 
nose of the rocket ship to the path of the motion.

 � Tip To direct the 
nose of the rocket ship, 
or any other object, 
along the path of its 
motion, you must 
orient its position so 
that it is facing in the 
direction that you want 
it to travel. Use the 
Free Transform tool to 
rotate its initial position 
so that it is oriented 
correctly.
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Swapping tween targets
The motion tween model in Animate is object based. This means that an object and 
its motion are independent of each other, and you can easily swap out the target of 
a motion tween. If, for example, you’d rather see an alien than a rocket ship mov-
ing around the Stage, you can replace the target of the motion tween with an alien 
symbol from your Library panel and still preserve the animation. This is especially 
useful when you want to work out the motion of a character before the design is 
final. You can create the animation with placeholder graphics and easily swap them 
in the end with the final versions.

1 Drag the movie clip symbol of the alien from the Library panel onto the 
rocket ship.

Animate asks if you want to replace the existing tween target object with a new 
object.

 � Note You can also 
use the Properties panel 
to swap instances. 
Select the object that 
you want to swap 
on the Stage. In the 
Properties panel, click 
the Swap button. In the 
dialog box that appears, 
choose a new symbol 
and click OK. Animate 
will swap the target of 
the motion tween.
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2 Click OK.

Animate replaces the rocket ship with the alien. The motion remains the same, 
but the target of the motion tween has changed.

Creating nested animations
Often, an object that is animated on the Stage will have its own internal animation. 
For example, the wings of a butterfly moving across the Stage may flap as the but-
terfly moves. Or the alien that you swapped with the rocket ship could be waving his 
arms. These kinds of animations are called nested animations because they are con-
tained inside the movie clip symbols. Movie clip symbols have their own timeline 
that is independent of the main timeline.

In this example, you’ll give the alien his own independent movement so he can wave 
as he flies across the Stage.

Creating animations inside movie clip symbols
We’ll animate some of the symbols that make up the alien’s body to allow him to wave.

1 In the Library panel, double-click the alien movie clip symbol icon.

You are now in symbol-editing mode for the alien movie clip symbol. The alien 
appears in the middle of the Stage. In the timeline, the parts of the alien are 
separated in layers.

 � Note If your symbol 
instance disappears 
from view after the 
symbol swap, choose 
View > Magnification > 
Show All (Command+3/
Ctrl+3) to change the 
zoom level to show all 
objects on the Stage.
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2 Select the Selection tool.

3 Select the alien’s left arm and choose Create Motion Tween.

Animate converts the current layer into a tween layer and inserts 1 second’s 
worth of frames so that you can begin to animate the instance.
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4 Select the Free Transform tool.

5 Move the mouse pointer near the corner transformation handle until the pointer 
changes to the rotation icon. Drag the corner handle near the hand to rotate the 
arm upward to the alien’s shoulder height.

A keyframe is inserted at the end of the motion tween. The left arm rotates 
smoothly from the resting position to the outstretched position.

6 Move the playhead back to frame 1.

7 Create a motion tween for the alien’s other arm. Select his right arm and choose 
Create Motion Tween.

Animate converts the current layer into a tween layer and inserts 1 second’s 
worth of frames.

8 Select the Free Transform tool if it’s not selected already.

9 As you did for the left arm, drag the corner transformation handle near the right 
hand to rotate the arm upward to the alien’s shoulder height.

Animate inserts a keyframe at the end of the motion tween. The arm rotates 
smoothly from the resting position to the outstretched position.

10 Select the last frame in all the other layers and insert frames (F5) so that the 
head, body, and feet all remain on the Stage for the same amount of time as the 
moving arms.
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11 Click the Scene 1 button in the Edit bar at the top of the Stage to exit symbol-
editing mode.

Your animation of the alien raising his arms is complete. Wherever you use the 
movie clip symbol, the alien’s nested animation will continue to play.

12 Preview the animation by choosing Control > Test, or use the Test Movie button 
in the upper-right corner of the Animate interface.

Animate opens a window showing the exported animation. The alien moves along 
the motion path while the nested animation of his arms moving plays and loops.

13 Save your project and close it. You’ll return to your previous animation in the 
next section.

 � Note Animations 
inside movie clip 
symbols won’t play 
on the main timeline. 
Choose Control > Test 
to preview nested 
animations, or use the 
Test Movie button at 
the upper-right corner 
of the interface.

 � Note Animations 
inside movie clip 
symbols will loop 
automatically. To 
prevent the looping, 
you need to add code 
to tell the movie clip 
timeline to stop on its 
last frame. You’ll learn to 
control those timelines 
with ActionScript or 
JavaScript in later 
lessons.

 � Tip Quickly build 
nested animations with 
a workflow shortcut, 
Convert Layers To 
Symbols. If you have 
an animation on the 
main timeline, simply 
select the layers, 
right-click, and choose 
Convert Layers To 
Symbol. Animate will 
put the selected layers 
into a symbol of your 
choosing and leave an 
instance of the symbol 
on the Stage.
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Easing
Easing refers to the way in which a motion tween proceeds. You can think of easing 
for changes in position as acceleration or deceleration. An object that moves from 
one side of the Stage to the other side can start off slowly, build up speed, and then 
stop suddenly. Or the object can start off quickly and then gradually slow to a halt. 
Your keyframes indicate the beginning and end points of the motion, but the easing 
determines how your object gets from one keyframe to the next.

A simple way to apply easing to a motion tween is to use the Properties panel. 
Easing values range from −100 to 100. A negative value creates a more gradual 
change from the starting position (known as an ease-in). A positive value creates a 
gradual slowdown (known as an ease-out).

A more advanced way of applying eases to a motion tween is to use the Motion 
Editor, which you’ll learn about in the next lesson.

Splitting a motion tween
Easing affects the entire span of a motion tween. If you want the easing to affect 
only frames between keyframes of a longer motion tween, you should split the 
motion tween. For example, return to the 03_workingcopy.fla file of the cinematic 
animation. The motion tween of the car in the Left_car layer begins at frame 75 and 
ends at frame 191, at the very end of the timeline. However, the actual movement 
of the car starts at frame 75 and ends at frame 100. You’ll split the motion tween so 
that you can apply an ease to the tween just from frame 75 to frame 100.

1 In the Left_car layer, select frame 101, which is the frame just after the second 
keyframe, where the car ends its movement.

2 Right-click frame 101 and choose Split Motion.
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The motion tween is cut into two separate tween spans. The end of the first 
tween is identical to the beginning of the second tween.

Motion tween split

3 In the Middle_car layer, select frame 94, right-click, and choose Split Motion to 
cut the motion tween into two separate tween spans.

4 In the Right_car layer, select frame 107, right-click, and choose Split Motion to 
cut the motion tween into two spans.

The motion tweens of all three cars have now been split.

Applying eases to motion tweens
You’ll apply an ease-in to the motion tweens of the approaching cars to give them a 
sense of weight and to make them decelerate, as real cars would.

1 In the Middle_car layer, select any frame between the first and second keyframes 
of the first motion tween (frame 70 to frame 93).

2 In the Tweening section of the Properties panel, enter 100 for the Ease value.

This applies an ease-out to the motion tween.
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3 In the Left_car layer, select any frame between the first and second keyframes of 
the first motion tween (frame 75 to frame 100).

4 In the Properties panel, enter 100 for the Ease value to apply an ease-out to the 
motion tween.

5 In the Right_car layer, select any frame between the first and second keyframes 
of the first motion tween (frame 78 to frame 106).

6 In the Properties panel, enter 100 for the Ease value to apply an ease-out to the 
motion tween.

7 Select Loop at the top of the Timeline panel and move the start and end markers 
in the timeline header to frames 60 and 115, respectively.

8 Click Play (Return/Enter).

Animate plays the timeline in a loop between frames 60 and 115 so that you can 
examine the ease-out motion of the three cars. The three cars slow down as they 
approach their final keyframes, giving them a sense of weight and realism.

Frame-by-frame animation
Frame-by-frame animation is a technique that creates the illusion of movement by 
making incremental changes between every keyframe. Frame-by-frame animation 
in Animate is similar to traditional hand-drawn cel animation, where each drawing 
is on a separate sheet of paper. It’s also just as tedious, but the results can be very 
creative.

Frame-by-frame animations increase your file size rapidly because Animate has to 
store the contents for each keyframe. Use frame-by-frame animation sparingly.
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In the next section, you’ll insert a frame-by-frame animation inside the carLeft 
movie clip symbol to make it move up and down in a jittery fashion. When the 
movie clip loops, the car will rumble slightly to simulate the idle of the motor.

Inserting a new keyframe
The frame-by-frame animations inside the carMiddle and carRight movie clip sym-
bols have already been done. You’ll finish the animation for the carLeft symbol.

1 In the Library panel, double-click the carRight movie clip symbol to examine its 
completed frame-by-frame animation.

Inside the carRight movie clip, three keyframes establish three different 
positions for the car and its headlights. The keyframes are spaced unevenly to 
provide the unpredictable up and down motion.

2 In the Library panel, double-click the carLeft movie clip symbol.
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You enter symbol-editing mode for the carLeft symbol.

3 Select frame 2 in both the lights layer and the smallRumble layer.

4 Choose Insert Keyframe (or F6).

Animate inserts a keyframe in frame 2 of the lights layer and the smallRumble 
layer. The contents of the previous keyframes are copied into the new keyframes.

 � Tip If the image 
of the car isn’t visible, 
select Fit In Window 
from the Zoom menu in 
the upper-right corner 
of the Stage.
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Changing the graphics
In the new keyframe, change the appearance of the contents to create the animation.

1 In frame 2, select all three graphics (the car and its two headlights) on the Stage 
(Edit > Select All, or Command+A/Ctrl+A) and move them down the Stage by 
1 pixel. Use the Properties panel to decrease the Y-position value by 1 pixel, or 
press the Down Arrow key to nudge the graphics by 1 pixel.

The car and its headlights move down slightly.

2 Repeat the process of inserting keyframes and changing the graphics. For a 
random motion like an idling car, using at least three keyframes is ideal.

Select frame 4 in both the lights layer and the smallRumble layer.

3 Choose Insert Keyframe (or F6).

Keyframes are inserted into frame 4 of the lights and smallRumble layers. The 
contents of the previous keyframes are copied into the new keyframes.

4 Select all three graphics on the Stage (Edit > Select All, or Command+A/Ctrl+A) 
and move them up the Stage by 2 pixels. You can use the Properties panel or 
press the Up Arrow key twice to nudge the graphics by 2 pixels.

The car and its headlights move up slightly.

5 You now have three keyframes for both layers inside the movie clip.

Test the idling motion by enabling the Loop option at the top of the Timeline 
panel and clicking Play (Return/Enter). Choose Control > Test to preview the 
entire animation.

Animating 3D motion
Finally, you’ll add a title and animate it in 3D space. Animating in 3D presents the 
added complication of a third axis (z). When you choose the 3D Rotation or 3D 
Translation tool, you need to be aware of the Global Transform option at the bot-
tom of the Tools panel (see the sidebar “Global vs. local transformations”). Global 
Transform toggles between a Global option (when you select the button) and a 
Local option (when you deselect the button). Moving an object in Global mode 
makes the transformation relative to the global coordinate system, whereas moving 
an object in Local mode makes the transformation relative to itself.

 � Tip You can navigate 
quickly between 
multiple keyframes 
by choosing Control > 
Step Forward To Next 
Keyframe (Alt/Option+.) 
or Control > Step 
Backward To Previous 
Keyframe (Alt/Option+,). 
You can also click the 
forward-pointing or 
backward-pointing 
arrow to the left of the 
playback controls at the 
top of the Timeline panel 
to move to the next 
or previous keyframe, 
respectively.

 � Note In this section, 
you created the car’s 
idling motion by 
manually moving the 
car’s position frame 
by frame. In the next 
lesson, you’ll learn to 
use the Refine Motion 
Tween panel, which can 
automatically modify 
your motion tween 
to simulate natural 
movements such as 
bounces or random 
jitters (as in the idling 
of a car).
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Global vs. local transformations
When you select the 3D Rotation or 3D Translation tool, be aware of the Global 
Transform toggle button found at the bottom of the Tools panel when one of the 3D 
tools is selected. When the button is toggled on (and highlighted), Global mode is 
engaged and the rotation and positioning of 3D objects are relative to the global, or 
Stage, coordinate system. The 3D display over the object that you’re moving shows 
the three axes in constant position, no matter how the object is rotated or moved. 
Notice in the following image how the 3D display is perpendicular to the Stage.

However, when the Global Transform option is turned off (the button is not high-
lighted), Local mode is in force and rotation and positioning are relative to the 
object. The 3D display shows the three axes oriented relative to the object, not to 
the Stage. For example, in the following image, notice that the 3D Rotation tool 
shows the rotation relative to the object, not to the Stage.

1 Click Scene 1 in the Edit bar to return to the main timeline. Insert a new layer at 
the top of the layer stack and rename it title.

2 Lock all the other layers.



ADOBE ANIMATE CC CLASSROOM IN A BOOK (2022 RELEASE) 159

3 Insert a new keyframe at frame 120.

4 Drag the movie clip symbol called movietitle from the Library panel onto the Stage.

The movietitle instance appears in your new layer in the keyframe at frame 120.

5 Position the title in the empty sky at X=180 and Y=90.

6 With the movie title selected, choose Create Motion Tween.

Animate converts the current layer to a tween layer so that you can begin to 
animate the instance.

7 Move the playhead to frame 140.

8 Select the 3D Rotation tool. The 3D Rotation tool is hidden in the additional 
tear-off tools at the bottom of the Toolbar (you’ll have to add it to your Toolbar 
to use it).
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The 3D rotation control appears on the selected movie clip.

9 Deselect the Global Transform button at the bottom of the Tools panel to put the 
3D Rotation tool into Local mode.

10 Drag the left arm of the green Y control to rotate the title around the y axis to 
angle it so that it seems to recede into the distance. Its angle is at about −50 
degrees. You can check the rotation values in the Transform panel (Window > 
Transform).

11 Move the playhead to the first keyframe, at frame 120.
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12 Drag upward on the right arm of the Y control to rotate the title around the y 
axis in the opposite direction so that the instance looks like just a sliver.

The change in the 3D rotation becomes a motion tween, so the title appears to 
swing in three dimensions.

Exporting your final movie
You can quickly preview your animation by “scrubbing” the playhead back and forth 
on the timeline, by choosing Control > Play, or by using the Time Scrub tool from 
the Tools panel. You can also use the integrated controller at the top of the Timeline 
panel. But to create your final project as a movie, you must export it.

Use the Quick Share And Publish option to create an MP4 movie file. Your anima-
tion is converted in Adobe Media Encoder, a freestanding application that is part of 
Adobe Creative Cloud (you’ll learn more about Media Encoder in the Bonus Lesson 
in the Web edition of this book).

1 Choose Quick Share And Publish > Publish > Video (.mp4). Click Publish.

 � Note Animating 
the 3D rotation 
or translation of a 
symbol is not currently 
supported in HTML5 
Canvas documents.
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Adobe Media Encoder automatically launches, and your project is exported and 
added to the Queue panel for processing.

2 The encoding process will begin automatically. If it doesn’t, click the Start Queue 
button (the green triangle) or press Return/Enter to begin the encoding process.

Media Encoder converts your project file into an H.264-formatted video with the 
standard .mp4 extension and notifies you when the process is finished.

Congratulations—you’re done! The final file can be uploaded to your favorite 
video-sharing sites or put up on a promotional website for the fictional cinematic 
release.

 � Note You can also 
publish an MP4 movie 
by choosing File > 
Export > Export Video/
Media. If you choose 
this route, you will 
have an opportunity 
to tinker with the 
options in Adobe Media 
Encoder and change 
audio/video encodings, 
cropping, trimming, and 
other properties of your 
video.
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Review questions
1 What are two requirements of a motion tween?

2 What kinds of properties can a motion tween change in an ActionScript 3.0 document?

3 What are property keyframes, and why are they important?

4 How can you edit the path of an object’s motion?

5 What does easing do to a motion tween?

Review answers
1 A motion tween requires a symbol instance on the Stage and its own layer, which is called a tween 

layer. No other tween or drawing object can exist on the tween layer.

2 A motion tween creates between different keyframes smooth transitions of an object’s location, 
scale, rotation, transparency, brightness, tint, filter values, or 3D rotation or translation.

3 A keyframe marks a change in one or more properties of an object. Keyframes are specific to each 
property, so a motion tween can have keyframes for position that are different from keyframes for 
transparency.

4 To edit the path of an object’s motion, choose the Selection tool and drag directly on the path 
to bend it. You can also choose the Convert Anchor Point tool and Subselection tool to pull out 
handles at the anchor points. The handles control the curvature of the path.

5 Easing changes the rate of change in a motion tween. Without easing, a motion tween proceeds 
linearly, where the same amount of change happens over time. An ease-in makes an object begin 
its animation slowly, and an ease-out makes an object end its animation slowly.
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NUMBERS

3D motion, animating, 157–161
3D Rotation tool, using, 158–161
3D Translation tool, using, 158–161

SYMBOLS

#000000 (black), choosing for fill and stroke, 60
#FFFFFF (white), choosing for fill, 60
* (asterisk), appearance of, 51

A

AATCs (Adobe Authorized Training Centers), 7
actions, adding for button click, 424–428
Actions panel. See also panels

Find And Replace command, 435
navigating, 419–420
pinning code in, 437

Actions panel wizard, adding JavaScript 
interactivity with, 421–428

ActionScript 3.0 document type, 12
ActionScript and JavaScript, 402
Adobe Animate

in-app tutorials, 6
improvements and updates, 2
installing, 3
layer parenting, 2
lesson files, 4
online content, 4
Paint Brush tool, 2
playback options, 2
prerequisites, 2
product home page, 7
registering, 4
resources, 5–7
rigging process, 2
starting, 10–11
Web Edition, 4
web tutorials, 6

Adobe Animate Assets panel. See Assets panel
Adobe Animate Learn & Support, 6
Adobe Assets panel, 288
Adobe Create, 7
Adobe Creative Cloud tutorials, 6
Adobe Extensions, 7
Adobe forums, 7
Adobe Media Encoder, using, 48, 161–162
Advanced option, Color Effects, 41
AIR document types, 12, 402
alien’s body example, 148–151
Align Center options, choosing, 104
Align panel, using, 108–109. See also panels
Alpha option, Color Effects, 41
Alpha value, modifying for fills, 90–91
Anchor option, Stage, 50

anchor points
adding to property curves, 172–174
adding, 75
constraining dragging motion, 175
controlling, 175
converting, 145
deleting, 68, 75, 175
moving, 69, 174–175
removing direction handles, 175
resizing direction handles, 175
undoing operations, 175

Animate
in-app tutorials, 6
improvements and updates, 2
installing, 3
layer parenting, 2
lesson files, 4
online content, 4
Paint Brush tool, 2
playback options, 2
prerequisites, 2
product home page, 7
registering, 4
resources, 5–7
rigging process, 2
starting, 10–11
Web Edition, 4
web tutorials, 6

animated buttons, 437–441. See also buttons
animated GIF, exporting, 394–395
animating

3D motion, 157–161
bounces, 186–189
camera moves, 330–333
color, 383–385
filters, 133–136
frame by frame, 154–157
hair, 306–308
mask and masked layers, 389–392
position, 122–125
shapes, 364–365
transformations, 137–140
transparency, 132–133
weightlifter, 272–274

animating rigs
adding drop shadow effect, 257–259
applying classic tweens, 255–256
creating keyframes, 253–255

animation loops, viewing, 302
animations. See also looping animation; movies; 

nested animations
changing duration of, 126–127
creating in movie clip symbols, 437–441
frame by frame, 154–157
inserting into graphic symbols, 373–374
in movie clip symbols, 148–151
moving, 141–142

INDEX
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overview, 121
playing at destinations, 432–436
previewing, 125, 373, 379–382
project file, 121–122
stopping, 435–436

ANP file, exporting to, 18
Application bar, locating, 15
arm wave, finishing, 207–209
armature. See also joints

applying to graphics, 321–325
applying without animation, 325
deselecting, 290
extending, 288–290
hierarchy, 290
moving bones in, 290–291
posing for pedaling cycle, 293–294
rearranging stacking order, 292–293
saving in Assets panel, 318–320

armature, building to animate characters, 285–288
art

exporting, 110–111
saving to Assets panel, 112–113

Art brushes, editing and creating, 83–85
Asset Warp tool. See also puppet warping

vs. Bone tool, 284–285
creating bones, 242–244
creating rigs, 238–242
mesh options, 248–250
moving rigs, 244–246
selecting, 261
using, 278
using rotation angles, 246–250

assets, exporting and importing, 114–115
Assets panel. See also panels

collaborating with, 112–115
improvements, 6
saving animated armature in, 318–320
saving assets in, 20
using, 288

asterisk (*), appearance of, 51
Auto-Recovery, using to create backup, 51–52

B

Background Color, changing for Stage, 19.  
See also color

background layer, creating, 87, 239
backups, creating with Auto-Recovery, 51–52
banner ad, opening, 400
Basic workspace, 16
beginning keyframes, creating for classic tweens, 

204–206
Bitmap Properties dialog box, using, 35
bitmaps

converting to, 111
swapping with symbols, 409–410
vs. vector shapes, 260

blend types, using with shapes, 368
Blur filter, applying, 101–102, 134
Blur values, increasing, 43–44
Bone tool

adding to Tools panel, 286

vs. Asset Warp tool, 284–285
using, 284–285

bones. See also joints and bones; soft bones for 
flexible connections

adding for rig edits, 276–277
in armature hierarchy, 290
creating for arms, 288
creating with Asset Warp tool, 242–244
defining inside shapes, 304–306
disabling snapping, 288
hard vs. soft, 267–272
isolating rotation of, 294–295
moving in armature, 290–291
moving with Asset Warp tool, 246
pinning, 295–296
removing and adding, 291
transformation point, 292

Bottle tool, using, 66
BounceIn ease, using, 189–191
bounces, animating, 186–189
bounding box, resizing, 140
branching rig, creating, 260–265. See also rigs
Brightness option, Color Effects, 41
Bring To Front command, using with armature, 293
broken tweens, 372
Brush Library, 80–82
brush modes, 79
brushes. See also paint brushes

Classic, 100
Fluid, 77–78, 100
using, 77–85

button click, adding actions for, 424–428
button instances

adding, 428–429
naming, 413–414
placing, 411–413

button symbols
creating, 403–405
editing, 405–407
using, 93

buttons. See also animated buttons; interactive 
navigation; invisible buttons and Hit 
keyframe

duplicating, 408–409
“Shop now,” 428–431
swapping bitmaps, 409–410

C

camera
animating pan, 338–339
animating rotation, 341–342
animating zoom-in, 340–341
animating zoom-out, 336–338
attaching layers for fixed graphics, 353–357
characteristics, 334
color effects, 357
creating depth, 345–352
enabling, 333–334
Layer Depth panel, 345–346
layers of stars, 346–348
Motion Editor, 345
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motion paths, 345
parallax effect, 345
Rotate and Zoom controls, 335
zoom and image resolution, 336

camera easing, 345
camera frame, setting, 334–336
Camera layer

attaching layers to, 353–354
disabling, 335

camera moves, finishing, 342–344
captions, adding for fixed graphics, 354–357
car example, 153–155
character animation

adding crank arm, 313–318
adding damping effects, 310–311
adding eases to, 302
adding poses, 300–304
Apply Skeleton, 324
building armature, 285–288
character animation with, 284–293
creating pedaling cycle, 293–296
disabling and constraining joints, 296–299
joint constraints, 300
Loop Playback, 302
rig mapping, 318–325
with shapes, 304–308
simulating physics with springiness, 308–311
tweening automatic rotations, 311–318

child and parent layers, classic tweens, 208
city layer, creating, 122
Classic Brush, using, 100
classic motion guide, editing path in, 218
classic tweens

adding motion guides, 214–218
advanced easing, 220–221
applying, 206
applying eases, 214
applying for rigs, 255–256
beginning and end keyframes, 204–206
child and parent layers, 208
easing for, 220–221
finishing arm wave, 207–209
vs. motion tweens, 204
nested animations, 218–219
swapping instances, 210–214
tweening parent layer, 209–210

Classroom in a Book, about, 1
closed versus open paths, 76
code, pinning in Actions panel, 437
code errors, displaying, 428
Code Snippets panel, 432. See also panels
collaborating with Assets panel, 112–115
color, animating, 383–385. See also Background 

Color; swatches and tagged swatches
color effects, camera, 357
Color Effects, Properties panel, 44
color hinting, advantage of, 428
colors, hexadecimal numbers, 58
Command key. See keyboard shortcuts
command menus, accessing, 15
constraining joints, 296–300
content, scaling, 49–51

control points, moving, 64
Convert Anchor Point tool, using, 145
Convert Layers to Symbol, using with nested 

animations, 218–219
Convert to Symbol dialog box, 404
Copy and Paste, using with shapes, 63
copying

layers, 32
and pasting curves, 177–180

corner points, adding, 66
corners, moving, 64
crank arm, adding, 313–318
Ctrl key. See keyboard shortcuts
Currency Wars, 166–167, 191
curved paths, creating, 76
curves. See also property curves

copying and pasting, 177–180
creating, 71–75
editing, 74–75

D

damping effects, adding, 310–311
debugging process, 428
deleting

anchor points, 68, 75, 175
bones, 291
color pointers from gradients, 88
layers, 25
movie clips, 291
property curves, 176
strokes and fills, 62

depth
creating, 90–91
creating with camera, 345–352

destination keyframes, creating, 415–419.  
See also keyframes

disabling joints, 296–300
document types

presets, 13
switching between, 12

documents, creating, 12–14
Double Identity, 159–162
Down state, button symbols, 405–406
downloading lesson files, 4
Drag And Drop Tools panel, 38–39
drawing

organizing, 69–71
rotating Stage for, 86

drawing modes, 60–61
drop shadow effect, adding to rig, 257–259
duplicating keyframes, 372
duration of animation, changing, 126–127
dynamic vs. static text, 103

E

ease curves vs. property curves, 186
Ease panel, Motion Editor, 183
ease-ins, adding, 183–185, 393
eases

adding motion tweens, 181–183
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adding to inverse kinematics, 302
animating bounces, 186–189
applying to classic tweens, 214
applying to motion tweens, 153–154
applying to property curves, 192–193
BounceIn, 189–191
removing, 185–186

easing. See also Edit Easing button; motion tweens
applying to motion tweens, 153–154
for classic tweens, 220–221
overview, 152
shape tweens, 393–395
splitting motion tweens, 152–153

Edit bar, locating, 15
Edit Easing button, locating, 220. See also easing
editing

Art and Pattern brushes, 83–85
button symbols, 405–407
curves, 74–75
frames, 140–142
layer parenting, 202
layer stacking, 202–203
path in classic motion guide, 218
path of motion, 145
property curves, 170–176
rigs, 250–253
shapes, 63–66
symbols from library, 98–99
symbols in place, 99–101
text, 103–108
width of lines, 67–69

editing tools, using, 218
educators, resources for, 7
ending keyframes, creating for classic tweens, 

204–206
errors, checking for, 428
Essentials workspace, 15–16, 22–29
events, defined, 424
exporting

animated GIF, 394–395
art, 110–111
Double Identity, 161–162
and importing assets, 114–115
Juno spacecraft example, 358–359

F

files
creating, 13
opening, 10–11
saving, 14

fills, modifying Alpha values of, 90–91
fills and strokes. See also variable-width strokes

changing, 66
deleting, 62–63
selecting, 62–63
understanding, 57–58
variable-width strokes, 66–69

filters
adding, 42, 134
animating, 133–136
applying for special effects, 101–102

enabling and disabling, 136
explained, 42
Options menu, 102
Quality menu, 102
rearranging, 136

final project, sharing, 110–111
Find And Replace command, Actions panel, 435
Fire starter graphic, 364
Fit In Window command, using, 156
Fixed and Open Handle modes, Warp Options, 280
fixed graphics, attaching layers to camera for, 353. 

See also graphics
FLA files, 12
flame layer, 365, 367
Flip Horizontal command, Transform, 316
Flip Vertical command, Transform, 316
floating panel, creating, 38. See also panels
Floral Brush 8 brush, using, 81
Fluid Brush, using, 77–78, 100
fly layer, creating, 215
folders. See layer folders
Format Code button, locating, 428
forward kinematics, 284–285
frame numbers vs. frame labels, 428
Frame Picker, using with lip-syncing, 222–229
frame rate

locating in Timeline panel, 22
understanding, 131

frame-based vs. span-based selection, 129
frame-by-frame animation, 154–157
frames

adding, 127–128, 181
adding to timeline, 414–415
editing, 140–142
expanding and compressing, 131
identifying in Timeline panel, 22
inserting in Timeline panel, 26
selecting in Timeline panel, 27

Free Transform tool
armature example, 290
car example, 138
eyes example, 64
octopus example, 96–97
rocket ship example, 146
rotating instance, 347
rotating upside down, 187

freezing joints, 265–267

G

GIF
exporting animations as, 394–395
exporting art as, 110–111

global vs. local transformations, 158
gotoAndPlay() action, using, 435
gradient fills

adjusting, 383–385
using, 87–90

Gradient Transform tool, using, 89–90, 383–385
graphic symbols

inserting animations in, 373–374
for lip-syncing dialogue, 221–231
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looping options for, 222
using, 94

graphics. See also fixed graphics; text
adding, 39–41
applying armature to, 321–325
changing for frame-by-frame animation, 157
and text lesson file, 56–57

grids and rulers, accessing, 18
grouping objects, 70–71
guides and rulers, using, 18, 109–110

H

H.264-formatted video, creating, 162, 359
hair

adding springiness to, 309–310
animating, 306–308

Hamlet’s soliloquy, 223
hard and soft bones, 271–272
head motion, adding, 230–231
hexadecimal numbers, using with colors, 58
hip joint, moving, 276
History panel, using, 36, 45–46
Hit keyframe and invisible buttons, 408
Hit state, button symbols, 405–406
Hosted Libraries, deselecting, 413.  

See also Library panel
HTML5 Canvas document type, 12, 402

I

importing items into Library panel, 20
information layer, creating, 353
installing Adobe Animate, 3
instances, swapping, 147, 210–214.  

See also symbol instances
interactive movies, 401. See also movies
interactive navigation. See also buttons

Actions panel, 419–428
ActionScript and JavaScript, 402
animated buttons, 437–441
checking for errors, 428
Code Snippets panel, 432
creating “Shop now” button, 428–432
destination keyframes, 415–419
JavaScript interactivity, 421–428
lesson files, 400–401
pinning code in Actions panel, 437
playing animation at destination, 432–436
preparing timeline, 414–415

interface, changing, 17
inverse kinematics

adding crank arm, 313–318
adding damping effects, 310–311
adding eases to, 302
adding poses, 300–304
Apply Skeleton, 324
building armature, 285–288
character animation with, 284–293
creating pedaling cycle, 293–296
disabling and constraining joints, 296–299
joint constraints, 300
Loop Playback, 302

rig mapping, 318–325
with shapes, 304–308
simulating physics with springiness, 308–311
tweening automatic rotations, 311–318

inverse kinematics with bones, lesson file, 284
invisible buttons and Hit keyframe, 408.  

See also buttons

J

JavaScript and ActionScript, 402
JavaScript interactivity, adding with Actions panel 

wizard, 421–428
joint constraints, on-Stage controls, 300
joint speed, changing, 303
Joint: X Translation, Properties panel, 299
Joint: Y Translation, Properties panel, 299
joints. See also armature

adding, 278–280
children and parents, 263
disabling and constraining, 296–300
freezing, 265–267
isolating, 274–276
repositioning, 291–292

joints and bones. See also bones; soft bones for 
flexible connections

explained, 285
reconnecting, 253
removing, 251–253
repositioning, 250–251

JPEG, exporting art as, 110–111
Juno spacecraft example, 330, 336, 356
Jupiter, zooming in for close-up of, 343

K

keyboard shortcuts
adding frames, 181
adding keyframes, 128
Bring To Front, 293
clearing keyframes, 29
constraining shapes, 60
Convert To Symbol, 94
Copy and Paste, 63
duplicating keyframes, 372
importing images into library, 21
inserting frames, 26
inserting keyframes, 28, 39, 44, 156
Library panel, 20
Loop Playback, 302, 373
Open command, 10
Paste In Place, 63, 316
previewing movies, 46
Properties panel, 34
redoing steps, 45
Select All, 141, 261
selecting keyframes, 129
Send To Back, 292
Shape Hints, 375
Show All command, 148
span-based vs. frame-based selection, 129
swatches, 92
Time Scrub tool, 125
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Undo, 45
undoing steps, 45
ungrouping objects, 70

keyframes. See also destination keyframes; poses; 
property keyframes

adding layer effects to, 42–45
adding stop() action for, 436
Auto Keyframe option, 369
creating for classic tweens, 204–206
creating for rigs, 253–255
creating in Timeline panel, 27–28
distributing uniformly, 127
duplicating, 372
duplicating with stop() actions, 436
inserting, 39, 44
inserting in frame-by-frame animation, 155–156
inserting with different content, 415–418
moving, 128–129
moving for shape tweens, 368–369
moving in Timeline panel, 29
moving keyframes, 130–131
navigating between, 157
removing, 29
and shapes, 366–367
using labels on, 418–419

L

labels, using on keyframes, 418–419
Layer Depth panel

camera, 345–346
setting z-depth in, 349–352

layer effects, adding, 41–45
layer folders, creating, 30
layer parenting

and classic tweens lesson file, 198
connecting monkey parts, 199–201
editing, 202
improvements, 2

layer stacking, editing, 202–203
layers. See also masked layers

adding to layer folders, 31
adding to Timeline panel, 24–25
attaching to camera for fixed graphics, 353–357
converting to symbols, 218–219
cutting, copying, pasting, and duplicating, 32
deleting, 25
displaying in Timeline panel, 22
hiding contents of, 25
highlighting, 31–32
locating, 15
lock icon, 24
organizing in timeline, 29–32
renaming in Timeline panel, 24
setting z-depth, 345
working with, 25

layers of stars, adding, 346–348
lesson files, accessing and using, 4–5
Library panel, working with, 20–21.  

See also Hosted Libraries; panels
lines, editing widths of, 67–69
lip-syncing dialogue

adding head motion, 230–231

Frame Picker, 222–229
graphic symbols for, 221–231

local vs. global transformations, 158
lock icon, appearance in layer, 24
Loop button, using to preview animations, 373
Loop Playback option, 302, 373
looping animation. See also animations

changing, 372–374
creating, 372–374

looping options for graphic symbols, 222

M

macOS, installing Adobe Animate on, 3
mask and masked layers, animating, 389–392
mask layer, defining, 386–387
masked layers. See also layers

animating, 389–392
creating, 387

masks
animating, 389–392
creating and using, 385–388

Merge Drawing mode, 60
Mesh options, using with rigs, 248–250
monkey parts, connecting in Parenting View, 

199–201
Motion Editor

and camera, 345
changing magnification, 176
copying and pasting curves, 178
Ease panel, 183
features, 167–168
Fit to View, 176
opening, 189
Restore Zoom to 100%, 176
transformation point, 172
values, 171–172
vertical axis, 171
viewing options for, 176
zoom level, 176

motion guides, adding for classic tweens, 214–218
motion paths and camera, 345
motion tweens. See also easing

3D Rotation, 158–161
adding, 168–170
applying eases to, 153–154, 181–183
vs. classic tweens, 204
creating, 123, 139, 169
duplicating, 179–180
explained, 121
lesson files, 166–168
removing, 125
splitting, 152–153

movie clip symbols
creating animations in, 437–441
creating animations inside, 148–151
removing and adding, 291
using, 93

movies. See also animations; interactive movies; 
testing movies

exporting, 161–162, 358–359
pausing with stop() action, 421
Quick Share and Publish, 47–49
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saving, 51–52
testing, 46–47, 151

moving
anchor points, 69
animation, 141–142
control points, 64
hip joint, 276
keyframes, 128–131
path of motion, 143–144
Warped Objects, 256

MP4 movie file, creating, 161–162

N

nested animations. See also animations
creating, 148–151, 218–219
of rotating wheels, 311–312

New Document dialog box, opening, 14

O

Object Drawing mode, 61
objects. See also Snap To Objects

aligning and distributing, 108–110
conversion to symbols, 122–125
displaying on stage, 148
grouping, 70–71
modifying, 61
orienting to path, 146
ungrouping, 70

octopus layer, creating, 58
On Mouse Click event, explained, 426
onion skinning, previewing animations with, 

379–382. See also shapes
online content, 4
Open command, choosing, 10
open versus closed paths, 76
opening files, 10–11
optimization options, resource for, 110
Oval tool, using, 58–60, 65
Over state, button symbols, 405–406

P

pace, changing, 368–369
pacing and timing, changing, 125–129
Paint Behind brush mode, 79
Paint Brush tool

refinements, 2
using, 80–82

paint brushes, managing, 85–86. See also brushes
Paint Bucket tool, using, 66, 73
Paint Fills Only brush mode, 79
Paint Inside brush mode, 79
Paint Normal brush mode, 79
Paint Selection brush mode, 79
pan, animating for camera, 338–339
panels. See also Actions panel; Align panel; Assets 

panel; Code Snippets panel; floating panel; 
Library panel; Properties panel; Timeline 
panel; Tools panel; Transform panel

arrangement in workspace, 16
working with, 36–37

parallax effect, camera, 345
parent and child layers, classic tweens, 208
parent bone in armature hierarchy, 290
parent layer, tweening, 209–210
Parenting View, connecting monkey parts in, 

199–201
Paste In Place command, using 63, 316
Paste vs. Paste to Fit Current Range, 179
pasteboard, Stage, 18
path of motion, changing, 142–146
paths

changing scale or rotation of, 144
creating with Pen tool, 76

Pattern brushes, editing and creating, 83–85
pedaling cycle, creating, 293–296
Pen tool

creating paths with, 76
using, 71–74

Pencil tool, Smooth option, 216
performance, improving, 111
phonemes and visemes, 222
photo1 file, creating, 24
photo2 file, creating, 25
photo2.jpg file, appearance on Stage, 29
photo3 layer, creating, 30
photos, rotating, 34–35
photos folder, creating, 30
physics, simulating with springiness, 308–311
Pin option, using with armature motion, 296
pinning code in Actions panel, 437
Play button, using, 302
playback options, improvements, 2, 11
PNG, exporting art as, 110–111
PolyStar tool, using, 39–41
poses. See also keyframes

editing on timeline, 302
inserting, 300–302
inserting for hair, 307

position, animating, 122–125
preferences

Auto-Recovery, 51
changing, 17
saving, 17
Undo commands, 45

previewing animations, 125, 373
Primitive Drawing mode, 61
projects, sharing, 110–111
Propagate Changes option, using with bones, 276–277
Properties panel. See also panels

Color Effects, 44
Joint: X Translation, 299
Joint: Y Translation, 299
locating, 15
using, 32–37
X and Y values, 34

property curves. See also curves
adding anchor points, 172–174
applying eases to, 192–193
changing curvature, 174
deleting, 176
vs. ease curves, 186
editing, 170–176
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Motion Editor values, 171–172
moving anchor points, 174–175

property keyframes, 136–137. See also keyframes
puppet warping.  

See also Asset Warp tool; Warp Options
adding joints, 278–280
animating rigs, 253–259
animating weightlifter, 272–274
editing rigs, 250–253
Fixed and Open Handle modes, 280
freezing joints, 265–267
hard and soft bones, 271–272
isolating joints, 274–276
lesson files, 236–237
overview, 237
propagating rig edits, 276–277
rigs with branching joints, 260–265
single joints, 278–280
soft bones for flexible connections, 267–270

Q

Quick Share and Publish, using with movies, 
47–49, 161–162. See also sharing projects

R

Rectangle tool, using, 60, 88, 355, 389, 403
redoing steps, 45
registering Adobe Animate, 4
replacements, doing, 435
resizing Stage, 49–51
rig edits, propagating, 276–277
rig mapping, 318–325
rigging process, 2
rigs. See also branching rig

animating, 253–259
with branching joints, 260–265
creating with Asset Warp tool, 238–242
Mesh options, 248–250
moving with Asset Warp tool, 244–246
repositioning joints and bones, 250–251

rocket ship example, 143–147
root bone in armature hierarchy, 290
rotating

photos, 34–35
Stage, 86

rotation, animating for camera, 341–342
rotation angles, using with Asset Warp tool, 246–248
rotation of bones, isolating, 294–295
rotation of joints, disabling, 297–298
Rotation tool, using, 86
rotations, tweening, 311–318
Ruby the rider, 286
rulers and grids, accessing, 18
rulers and guides, using, 109
runtime environment, 11

S

Save As option, using, 51
saving

art to Assets panel, 112–113

assets, 20
files, 14
movies, 51–52
preferences, 17
Uncompressed Document, 14
workspace, 16–18

Scale option, Tweening section, 208
scaling

content, 49–51
Stage, 18

“scrubbing” playhead, 161
Select All command, using, 141, 261
Selection tool

editing path of motion, 145
and Subselection tool, 74–75
using with bones, 288
using with Oval tool, 59
using with shape contours, 65
using with strokes and fills, 62

selections
making, 61–63
span based vs. frame based, 129

Send To Back command, using with armature, 292
shape contours, changing, 65–66
shape hints, using, 375–379
shape tweens

adding, 369–371
animating colors, 385
applying, 367
breaking, 372
changing pace, 368–369
creating, 365–371
easing, 393–395
extending, 371
inserting keyframes, 369–371
moving keyframes, 368–369
with variable-width strokes, 374

shapes. See also onion skinning
animating, 364–365
blend types, 368
changing transparency of, 91
constraining, 60
creating, 58–61
defining bones inside, 304–306
editing, 63–66
and keyframes, 366–367

sharing projects, 110–111.  
See also Quick Share and Publish

Shift key. See keyboard shortcuts
“Shop now” button, creating, 428–431
Show All command, using, 148
skeleton, applying, 324
smooth curves, connecting, 76
Snap To Objects. See also objects

deselecting, 288
selecting, 217, 376

snapping, disabling for bones, 288
Snow White and the Seven Dwarfs, 345
soft and hard bones, 271–272
soft bones for flexible connections, 267–270.  

See also bones; joints and bones
spaces, adding for groups of tools, 38
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span-based vs. frame-based selection, 129
special effects, applying filters for, 101–102
Split Motion command, choosing, 152
springiness, simulating physics with, 308–311
Stage

adding items from Library panel, 21
Anchor option, 50
Background Color, 19
changing properties, 19
displaying objects on, 148
features, 18
Fit In Window command, 156
identifying, 15
pasteboard, 18
pixel dimensions, 50
positioning objects on, 34–35
properties, 19
resetting orientation of, 86
resizing, 49–51
rotating, 86
rulers and grids, 18
scaling, 18
viewing in full-screen mode, 18

stars, adding layers of, 346–348
stars layer, creating, 39
starting Adobe Animate, 10
static vs. dynamic text, 103
steps

redoing, 45
undoing, 45–46

stop() action
adding for keyframes, 436
duplicating keyframes with, 436
using to pause movies, 421, 423

stopping animations, 435–436
stroke, changing curvature of, 65
strokes and fills. See also variable-width strokes

changing, 66
deleting, 62–63
selecting, 62–63
understanding, 57–58
variable-width strokes, 66–69

Subselection tool, using, 74–75, 145
SVG (Scalable Vector Graphics), exporting art as, 111
Swap Symbol icon, locating, 212. See also symbols
swapping

bitmaps and symbols, 409–410
instances, 210–214
tween targets, 147

swatches and tagged swatches, using, 92.  
See also color

SWF animation, 344
symbol instances. See also instances

adding, 95–96
breaking apart, 101
changing color effects, 97–98
editing from library, 98–99
editing in place, 99–101
managing, 95–101
overlapping, 96–97
repositioning, 96–97
resizing, 96–97

symbols. See also Swap Symbol icon
converting layers to, 218–219
converting objects to, 122–125
creating, 94–95
duplicating in Library panel, 99
instances of, 93
overview, 92–94
swapping with bitmaps, 409–410
types of, 93–94

T

tagged swatches and swatches, using, 92
tentacle symbol, naming, 94
testing movies, 10, 46–47, 151, 219, 284
text. See also graphics

creating and editing, 103–108
static vs. dynamic, 103

text layer, creating, 103
Text tool, using, 103–104
Time Scrub tool, using, 125
timeline

changing appearance of, 23
organizing layers in, 29–32
preparing for content, 414–415
stopping, 421–424

Timeline panel. See also panels
adding layers, 24–25
creating keyframes, 27–28
frame rate, 22
inserting frames, 26
layers, 22
locating, 15
moving keyframes, 29
overview, 22
removing keyframes, 29
renaming layers, 24
selecting frames, 27

timing and pacing, changing, 125–129
Tint option, Color Effects, 41
title layer, creating, 158
To_Be_or_Not.wav file, dragging from Library, 223
tools

3D Translation, 158–161
adding spaces for, 38
adding to Toolbar, 38
Asset Warp, 238–250, 261, 278, 284–285
Bone, 284–286
Bottle, 66
Convert Anchor Point, 145
Drag And Drop Tools panel, 38–39
Free Transform, 64, 96–97, 138, 146, 187, 

290, 347
Gradient Transform, 89–90, 383–385
Oval, 58–60, 65
Paint Brush, 2, 80–82
Paint Bucket, 66, 73
Pen, 71–74, 76
Pencil, 216
PolyStar, 39–41
Rectangle, 60, 88, 355, 389, 403
Rotation, 86
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selecting and using, 37–38
Selection, 59, 62, 65, 74–75, 145, 288
Subselection, 74–75, 145
tearing off, 38–39
Text, 103–104
Time Scrub, 125
Width, 67–68, 374

Tools panel. See also panels
adding Bone tool to, 286
locating, 15
using, 37–41
widening, 39

Transform panel, using to rotate photos, 34–35. 
See also panels

transformations
animating, 137–140
global vs. local, 158

transition animations, creating, 432–434
transparency

animating, 132–133
changing for shapes, 91
using to create depth, 90–91

tween layer, creating, 139, 149
tween spans

changing lengths of, 127
changing time in, 130–131

tween targets, swapping, 147–148
“tween” terminology, 121
tweening 

automatic rotations, 311–318
parent layer, 209–210

Tweening section, Scale option, 208
tweens, adding to masked layers, 389–392

U

ultra button symbol, creating, 404
Uncompressed Document, saving, 14
undoing steps, 45–46
Up state, button symbols, 405–406

V

variable-width strokes. See also strokes and fills
shape tweening with, 374
using, 66–69

vector art, 111
vector shape, creating rig on, 260
visemes and phonemes, 222
VR 360 and VR Panorama document types, 12, 402

W

Wacom graphics tablets, support for, 85
Walt Disney Studios, 345
Warp Options. See also puppet warping

animating weightlifter, 272–274
Fixed and Open Handle modes, 280
freezing joints, 265–267
isolating joints, 274–276
soft bones for flexible connections, 267–270

Warped Object, moving, 256
Web Edition, accessing, 4
web fonts

adding, 105–107
removing, 107–108

WebGL-glTF-Extended or -Standard document 
type, 12, 402

weightlifter, animating, 260, 272–274
Width tool, using, 67–68, 374
Windows, installing Adobe Animate on, 3
woman layer, creating, 239
workspace

choosing, 15–16
features, 308–311
panels in, 16
saving, 16–18
switcher, 16

X

X and Y values, Properties panel, 34
XFL (Animate) files, 12, 14

Z

z-depth, setting for layers, 345, 349–352
zoom-in, animating for camera, 340–341
zoom-out, animating for camera, 336–338
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